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			Preface

			Autodesk Civil 3D connects to an entire network of other software to take your project farther than you would imagine for civil engineering design. You will be able to put your knowledge to work with this practical guide on civil engineering design. This book provides a hands-on approach to implementation and associated methodologies that will have you and your team functional and productive in no time.

			This book covers all the major features Civil 3D has to offer, whether surface development, intelligent utility design, or dynamic display work for creating smart documentation. You’ll learn how best to configure and manage your civil engineering designs by successfully leveraging all that Autodesk Civil 3D has to offer. You’ll then learn how to practically apply the tools and modeling techniques available within the software.

			By the end of this book, you will have a thorough understanding of Autodesk Civil 3D, along with its partner programs, and be able to strategize how best to utilize it on your next project.

			Who this book is for

			This book is for civil engineers, environmental engineers, surveyors, civil designers, civil technicians, Civil 3D professionals, and InfraWorks professionals looking to understand how to best leverage Civil 3D in their everyday designs.

			You’ll need to have a very basic understanding of civil engineering and surveying workflows, as well as a foundational understanding of Autodesk’s AutoCAD, to make the most of this book. A basic understanding of surveying, civil/environmental engineering practices, and AutoCAD drafting knowledge is assumed.

			What this book covers

			Chapter 1, Introduction to Civil 3D, begins by exploring the program itself. This is where the main tools are, and you will familiarize yourself with the working space. We will explore the user interface and review where objects are stored as they are created.

			Chapter 2, Setting up the Design Environment, reviews how work is logged and integrated as more complexity is added. We will explore how modeled components and geometry can be affected by dynamic display styles and how to create a new file for a design project.

			Chapter 3, Sharing Data within Civil 3D, demonstrates the power of Civil 3D as a program, not only showing how to design a basic project in Civil 3D but also how to scale your workflows to include more team members for larger project sizes while maintaining efficiency.

			Chapter 4, Configuring Survey Data with Civil 3D, contains all you need to know about bringing in existing survey data with proper formatting and how to establish an accurate depiction of a yet-to-be-designed project site, given that civil design always begins with existing conditions.

			Chapter 5, Leveraging Points, Lines, and Curves, dives into the application and intersection of Civil 3D’s tools, now that we understand the basic tools and methods, to better develop a confident infrastructure design. Civil 3D is a dynamic program that not only makes use of intelligent components and design processes but also integrated workflows that adjust when dependent parts of the design adjust or change, which results in less time spent recreating work or formatting when work is updated automatically.

			Chapter 6, Surfaces - The First Foundational Component to Designs within Civil 3D, elaborates on one of the three foundational modeling elements, which is surface modeling, required for almost every civil engineering-related design.

			Chapter 7, Alignments - The Second Foundational Component to Designs within Civil 3D, is all about the second foundational modeling element required, which is alignments, pertinent to almost every civil engineering-related design.

			Chapter 8, Profiles - The Third Foundational Component to Designs within Civil 3D, explains the third and final foundational modeling element, which is profiles, as it applies to almost every civil engineering-related design.

			Chapter 9, Land Development Tool Belt for Everyday Use, involves putting on our Land Development Tool Belt and jumping into the world of subdivisions, parks, and overall civil site design.

			Chapter 10, Roadway Modeling Tool Belt for Everyday Use, has us put on our Roadway Modeling Tool Belt and jump into the world of transportation.

			Chapter 11, Advanced Roadway Modeling Tool Belt for Everyday Use, continues to expand upon our Roadway Modeling Tool Belt and jumps into advanced applications to transportation.

			Chapter 12, Utility Modeling Tool Belt for Everyday Use, walks through a final specialized set of tools, the Utility Tool Belt, and jumps into the world of utility infrastructure, which ultimately services our communities and land.

			Chapter 13, Section Creation and Analysis, reviews how to create, display, and manage Section Views within Civil 3D.

			Chapter 14, Automating Sheet Creation, teaches you how to automate sheet creation and migrate your design from a modeled state to a true design deliverable.

			To get the most out of this book

			
				
					
					
				
				
					
							
							Software/hardware covered in the book

						
							
							Operating system requirements

						
					

					
							
							Autodesk AutoCAD

						
							
							Windows or macOS

						
					

					
							
							Autodesk Civil 3D

						
							
							Windows or macOS

						
					

				
			

			If you are using the digital version of this book, we advise you to use the datasets available as you work through each chapter. Instructions are available within the chapters that detail whether readers will need to create a new drawing from scratch or open a file that has already been prepared. Doing so will help you follow the steps outlined.

			Disclaimer

			To ensure that a timely publication of this book’s content is in close alignment with Autodesk’s product release cycle, you may notice as you progress through our Civil 3D 2024 learning journey that there are several images displayed in referenced Figures that depict an earlier release of Civil 3D. It’s important to note that features and workflows discussed throughout this book are still relevant and applicable in Autodesk’s Civil 3D 2024 product and in which we will be applying throughout our learning journey.

			Download the exercise files

			You can download the exercise files for this book at https://packt.link/UoiPn

			Download the color images

			We also provide a PDF file that has color images of the screenshots and diagrams used in this book. You can download it here: https://packt.link/2lHjT.

			Conventions used

			There are a number of text conventions used throughout this book.

			Code in text: Indicates code words in text, database table names, folder names, filenames, file extensions, pathnames, dummy URLs, user input, and Twitter handles. Here is an example: “Please note that if your design references metric units, you can select the _Autodesk Civil 3D (Metric) NCS.dwg drawing template to ensure that correct units are applied to your drawing.”

			Bold: Indicates a new term, an important word, or words that you see onscreen. For instance, words in menus or dialog boxes appear in bold. Here is an example: “Any time you create a new drawing by going to Menu Browser and selecting New | Drawing, a dialog box will appear for you to select the drawing template.”

			Tips or important notes

			Appear like this.

			Get in touch

			Feedback from our readers is always welcome.

			General feedback: If you have questions about any aspect of this book, email us at customercare@packtpub.com and mention the book title in the subject of your message.

			Errata: Although we have taken every care to ensure the accuracy of our content, mistakes do happen. If you have found a mistake in this book, we would be grateful if you would report this to us. Please visit www.packtpub.com/support/errata and fill in the form.

			Piracy: If you come across any illegal copies of our works in any form on the internet, we would be grateful if you would provide us with the location address or website name. Please contact us at copyright@packt.com with a link to the material.

			If you are interested in becoming an author: If there is a topic that you have expertise in and you are interested in either writing or contributing to a book, please visit authors.packtpub.com

			Share Your Thoughts

			Once you’ve read Autodesk Civil 3D from Start to Finish, we’d love to hear your thoughts! Please select https://www.amazon.in/review/create-review/error?asin=1803239069 for this book and share your feedback.

			Your review is important to us and the tech community and will help us make sure we’re delivering excellent quality content.

			Download a free PDF copy of this book

			Thanks for purchasing this book!

			Do you like to read on the go but are unable to carry your print books everywhere?

			Is your eBook purchase not compatible with the device of your choice?

			Don’t worry, now with every Packt book you get a DRM-free PDF version of that book at no cost.

			Read anywhere, any place, on any device. Search, copy, and paste code from your favorite technical books directly into your application. 

			The perks don’t stop there, you can get exclusive access to discounts, newsletters, and great free content in your inbox daily

			Follow these simple steps to get the benefits:

			
					Scan the QR code or visit the link below

			

			 

			
				
					[image: ]
				

			

			https://packt.link/free-ebook/9781803239064

			
					Submit your proof of purchase

					That’s it! We’ll send your free PDF and other benefits to your email directly

			

		

	


		
			Part 1: Getting Acquainted with Civil 3D and Starting Your Next Project for Success

			Civil 3D is intelligent civil design software with dynamic elements that can link together throughout the course of your design and its refinement.

			The following chapters are included in this section:

			
					Chapter 1, Introduction to Civil 3D

					Chapter 2, Setting up the Design Environment

					Chapter 3, Sharing Data within Civil 3D

			

		

		
			
			

		

	


		
			1

			Introduction to Civil 3D

			Autodesk’s Civil 3D has been the leading design authoring tool of choice supporting civil engineering design applications since the early 2000s. Designers working with Civil 3D are able to put their knowledge to work with this practical guide to civil engineering design. This textbook is intended for civil designers with a basic understanding of Civil 3D and its workflows.

			With this book, you will learn how best to configure and manage your civil engineering designs by successfully leveraging all that Autodesk Civil 3D has to offer. 

			We will begin by exploring best practices and real-world applications that will elevate your designs with Civil 3D. Autodesk Civil 3D connects to an entire network of other platforms and technologies to take your project further than you would imagine for civil engineering designs. By the end of this book, you will have a thorough understanding of Autodesk’s Civil 3D and will be able to strategize how best to utilize it in your next project.

			In this chapter, we will provide some background and history to help you realize the benefits of leveraging Autodesk’s Civil 3D and understand its place within the Architeture, Engineering and Construction (AEC) industry. We will then familiarize ourselves with the overall user interface to understand all the tools and functionality available within Autodesk’s Civil 3D, allowing you to maintain a high level of efficiency as you work through your design(s). Finally, to gain all of the benefits that Civil 3D has to offer and maintain a high level of efficiency and consistency, you’re going to learn how to leverage as much of Civil 3D’s dynamic capabilities as possible to support your Building Information Modeling (BIM) design(s).

			So, in this chapter, we will cover the following topics:

			
					What is Civil 3D?

					The user interface

					Understanding Civil 3D elements

			

			Technical requirements

			It’s important to note that Autodesk’s Civil 3D can often be very taxing to your computer. There is a lot of processing that goes on with modeled design elements, even in the background, that enables the dynamic (connected) capabilities to occur throughout the BIM design life cycle. In turn, there are many technical requirements that need to be considered to allow Autodesk’s Civil 3D to operate at its full potential. Here, we’ll review the minimum requirements that Autodesk recommends, with a few of my suggestions added to increase efficiency and speed throughout the BIM design process:

			
					Operating system – 64-Bit Microsoft Windows 10

					Processor – 3+ GHz

					Memory – 16 GB RAM (I suggest going with either 64 GB or 128 GB)

					Graphics card – 4 GB (I suggest going with 8+ GB)

					Display resolution – 1980 x 1080 with True Color

					Disk space – 16 GB

					Pointing device – MS-Mouse compliant

			

			What is Civil 3D?

			We’ve all heard the term BIM being thrown around for quite some time now. In general, BIM is the process typically applied to and associated with intelligently and dynamically designing an actual building or structure, where architects/engineers and designers can visualize and anticipate the true constructability of a project.

			On the survey and civil engineering side, we’ve been generating, designing, and modeling everything outside buildings/structures in a 3D environment for just as long, if not longer, than the term BIM has been around. However, for one reason or another, these designs have not typically been viewed as BIM by the vast majority.

			This is where Autodesk’s Civil 3D comes into the picture. Civil 3D is essentially a BIM design authoring tool that fully supports both surveying and civil engineering designs. When utilized the right way, we have the power to create and manage intelligently designed models, perform cost estimations, interfence checks/clash detections, prepare our models for construction sequencing, and even perform asset management integrations well beyond design.

			It’s important to note that Autodesk’s Civil 3D is considered a vertical application of Autodesk’s AutoCAD. A vertical application in this context essentially means that Civil 3D is built on top of AutoCAD, thereby still providing a lot of 2D-focused tools and functionality. To make the transition from 2D to 3D, we’ll need to realize the separation of where the content resides and how the application of tools differs in each world. Throughout the course of this book, I will cover both 2D and 3D applications of design intent to provide a bit more insight as to how and when to apply each of them.

			Historically, it is always recommended that anyone looking to fully utilize Civil 3D should have a basic understanding of AutoCAD to establish that foundation. Depending on the individual learning, that concept is more frequently dismissed as it has the potential to root bad design habits in those not willing to fully embrace the 3D world. As Civil 3D continues to evolve and become more of a model-centric focused design authoring tool, the industry has a much better opportunity to fully embrace the concept of BIM and design with intelligence from the beginning.

			What types of BIM projects can Civil 3D manage?

			When trying to determine how Civil 3D can best be utilized from a design standpoint, we’re going to break down the tools and functionality into the following three main design categories or markets: land development, utilities, and transportation. In addition to the three main design categories, it’s important to realize all projects, whether building or infrastructure, rely upon existing conditions, and Civil 3D is a great partner for hosting these parameters as well as modeling new ones for a complementary design to the interior of the structure. This added benefit is heavily relied on and supported in the surveying industry as well.

			In this course, we’ll cover all four of these categories in great length as follows:

			
					From a surveying perspective, we’ll cover tools that allow for full integration of survey databases, field books, existing conditions modeling, and even point cloud integration from drone and laser scan technology. Any BIM design being generated can only be as accurate as the survey and existing conditions model, making these early steps critical to successful design downstream.

					From a land development perspective, we’ll cover methods that allow a wide array of civil site designs including subdivisions, residential/commercial sites, parks, and even environmental designs.

					From a utility perspective, we’ll cover tools and functionality that support storm drainage, sanitary sewer, waterline, and natural gas designs.

					From a transportation perspective, we’ll cover tools and functionality that support roadway designs, rehabilitations, and access roads. Additionally, we’ll cover tips and tricks on how some of these tools can be applied in civil site designs and even stream and restoration projects.

			

			Understanding real-world applications of any new technology solution is critical from an overall adoption and implementation standpoint. Throughout this book, especially as we dive deeper into the specific tools and functionality of Autodesk’s Civil 3D, we’ll begin to understand how and why it is viewed as a leading design authoring tool supporting the AEC industry.

			Let’s go ahead and jump into the program to begin to familiarize ourselves with the user interface to get an idea of where to locate all of the tools and functionality available to us.

			Exploring the Civil 3D user interface

			With all the introductions and background out of the way, let’s go ahead and jump into Autodesk Civil 3D and get acquainted with this BIM platform. When Autodesk Civil 3D is opened up or launched, you will be presented with the Start tab/screen, similar to that shown in Figure 1.1:

			
				
					[image: Figure 1.1 – User interface when Autodesk’s Civil 3D is launched

]
				

			

			Figure 1.1 – User interface when Autodesk’s Civil 3D is launched

			If we then select the + sign next to the Start tab, we will see we have essentially created our first drawing and will be presented with a screen similar to that shown in Figure 1.2:
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			Figure 1.2 – User interface after our first drawing has been created

			Along the very top of the program, you are presented with three levels of tools and functionality, as shown in Figure 1.3:

			
				
					[image: Figure 1.3 – Top three levels of tools and functionality within the user interface
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			Figure 1.3 – Top three levels of tools and functionality within the user interface

			Each of these levels provides varying access to the tools and functionality available within Autodesk’s Civil 3D platform. Much of this should be a bit clearer by the end of the section, as we dive into more detail about what is available at each level.

			The first tier of the ribbon

			In the first level at the very top, reading from left to right, we have access to the Menu browser, Quick Access Toolbar, Workspace and Quick Access Toolbar Customizations, Application and Drawing currently visible in the Drawing area, Quick Search Access to Autodesk’s Civil 3D Help, Autodesk Account Access, Overall Autodesk’s Civil 3D Help, and Quick program visibility access.

			Starting with the Menu browser, which is indicated by the Civil 3D icon in the top-left corner of the program, you will be presented with a multitude of options that will provide some very high-level drawing management and functionality. Select the icon by left-clicking on your mouse (refer to Figure 1.4 for a detailed view of the Menu browser):

			
				
					[image: Figure 1.4 – Detailed view of the Menu browser
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			Figure 1.4 – Detailed view of the Menu browser

			Running through the options presented along the left side of the Menu browser from the top to the bottom, the following list details what each area provides:

			
					New: This selection allows end users to create new drawings and sheet sets (more on sheet sets in Part 4 of the book).

					Open:This selection allows end users to open existing drawings (both locally or web and mobile-based), access Sheet Set Manager, import DGN files (Microstation format), import Industry Foundation Class (IFC) files, and open sample files (both locally or from online).

					Save: This selection allows end users to perform a quick save of their current drawing.

					Save As: This selection allows end users to save their current drawing as another drawing (both locally or web and mobile-based), drawing template file, drawing standards file, other formatted files (that is, DWG, DWDT, WS, and DXF), save the layout as a drawing file, and DWG Convert which will allow us to save to a DWG format that is compatible with earlier releases of Civil 3D).

					Export: This selection allows end users to export their current drawing to a DWF, DWFx, 3D DWF, another DWG version, DGN, DXF, PDF, IFC, and other file formats (that is, WMF, SAT, STL, EPS, DXX, BMP, IGES, and IGS).

					Publish: This selection allows end users to access the Send to Print service, Archive, eTransmit, Email, and Share View.

					Print: This selection allows end users to access Plot, Batch Plot, Plot Preview, View Plot and Publish Details, Page Setup, 3D Print, Manage Plotter, Manage Plot Styles, and Edit Plot Style Tables.

					Suite Workflows: This selection allows end users to access Workflow Manager, a dedicated area for common automated tasks.

					Drawing Utilities: This selection allows end users to access Drawing Properties, DWG Compare, Drawing Settings, Units, Audit, Status, Purge, Recover, Open the Drawing Recovery Manager, and Update Block Icons.

					Close: This selection allows end users to close the current drawing or all drawings.

			

			Moving onto Quick Access Toolbar, we have a lot of the same options available to us as are within the Menu browser. However, instead of a drop-down menu like that of the Menu browser, we quick-select icons of tools and functionality that are typically common to everyday workflows:

			
				
					[image: Figure 1.5 – Quick Access Toolbar

]
				

			

			Figure 1.5 – Quick Access Toolbar

			Running through the stock, out-of-the-box Quick Access icons from left to right (as shown in Figure 1.5), we have the following:

			
					New

					Open

					Save

					Open from Web & Mobile

					Save to Web & Mobile

					Plot (print)

					Undo

					Redo

			

			Note

			Next to the Undo and Redo icons in Quick Access Toolbar, there are down arrows that will allow you to select the number of steps for which you would like to perform that operation on your drawing. By simply selecting the icon instead of the down arrow, you will perform that operation once for each click of the mouse. If you are intending to perform that operation multiple times, I recommend using the down arrow next to the icon to get the drawing back to the state that you are expecting.

			If there are additional tools that are typical to your everyday workflow, there is a way to add them to your toolbar by simply right-clicking on the tool in the ribbon and selecting Add to Quick Access Toolbar.

			Next, we have the Workspace and Customized Quick Access toolbar. Here you can change the tools available in the ribbons on the third and fourth levels depending on the type of design and analysis you are looking to perform within the current drawing. To change from one workspace to another, you can select the down arrow icon next to the workspace name and select a different one as appropriate (see Figure 1.6).
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			Figure 1.6 – Workspace selections

			Workspaces displayed and available include the following:

			
					Civil 3D: Tools displayed in the ribbon will provide you with the bulk of the tools necessary to perform civil engineering design and analysis.

					Drafting & Annotation: Tools displayed in the ribbon will provide you with the basic 2D drafting tools and functionality.

					3D Modeling: Tools displayed in the ribbon will provide you with the basic 3D modeling tools and functionality. It’s important to note that 3D modeling capabilities within this display are not Civil 3D-related but are more intended for basic AutoCAD functionality.

					Planning and Analysis: Tools displayed in the ribbon will provide you with additional mapping and analysis tools. These tools come in handy when connecting to ArcGIS data.

					Save Current As…: Provides the ability to save any customizations you have made to a customized workspace that can be made current later on.

					Workspace Settings…: Selecting this option will pull up another dialog box that will allow you to define which workspaces are available, as well as the display order of the workspaces listed.

					Customize…: Selecting this option will pull up another dialog box that will allow you to customize any of your workspaces if necessary. This will come in handy if you intend to create custom tools, layouts, and so on specific to your workflow.

			

			Directly next to the workspace selections is another down arrow with a horizontal line above it. If you select this, you will be presented with a drop-down menu that will provide the ability to customize Quick Access Toolbar and Tools Available within the overall ribbon interface (refer to Figure 1.7):
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			Figure 1.7 – Customize Quick Access Toolbar

			Those items that are checked will be displayed in Quick Access Toolbar in your current view. You’ll notice that all of those checked in Figure 1.7 were those that were displayed when we were reviewing Quick Access Toolbar (Figure 1.5). The remaining tools listed in the top section are fairly straightforward and are typical commands and functionality that are relied on for a lot of workflows, hence the reason why they are listed as optional defaults in the list.

			The last option in Quick Access Toolbar is an icon that looks like a paper airplane (see Figure 1.8). Selecting this icon will allow you to share the current drawing via a link to a web-based version. By default, the drawing is only available for 7 days.
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			Figure 1.8 – Share the drawing with a link

			Next, we have Application and Drawing currently visible in the drawing area (refer to Figure 1.9). As you open or create and save new drawings, the drawing name displayed in this location will update accordingly.

			
				
					[image: Figure 1.9 – Application and Drawing
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			Figure 1.9 – Application and Drawing

			Then, we move on to Quick Search Access to Autodesk’s Civil 3D Help (refer to Figure 1.10). Any time you find yourself needing some quick help on a specific command, simply type the name of the command in this location and click on the magnifying glass icon next to it. After selecting the magnifying glass icon, another window will appear that contains the Civil 3D Help documentation and will present you with results that match the keyword or phrase you had typed into the field.
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			Figure 1.10 – Quick Search Access

			Next up is Autodesk Account Access. Viewing from left to right, we first have Account Login and Details presented to you. When selecting the down arrow icon in the view (refer to Figure 1.11), you will have the ability to log out, view account details, explore purchase options, and manage licenses.
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			Figure 1.11 – Autodesk Account Access

			Next to Autodesk Account Access (refer to Figure 1.12), we are presented with the option to connect to the Autodesk App Store (indicated by the shopping cart icon) and to connect to Civil 3D user networks via Facebook and Twitter:
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			Figure 1.12 – Autodesk App Store and user group networks

			Continuing on, we have the overall Autodesk Civil 3D Help access, which is identified by the question mark icon (see Figure 1.13):
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			Figure 1.13 – Autodesk Civil 3D Help

			And finally, we come to the quick program visibility access, where we have the ability to minimize the window of the program, restore and maximize the window of the program, and close the entire program:
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			Figure 1.14 – Quick program visibility

			With the contents of the first tier behind us, let’s jump into the second tier.

			The second tier of the ribbon

			In the second level of the ribbon interface, we have the tabs that essentially group all of the tools and functionality available within Autodesk’s Civil 3D (refer to Figure 1.15). This grouping is meant to be an easy way to quickly access tools as you need them, instead of having to search through the drop-down menus for tools as needed.
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			Figure 1.15 – Second tier

			Starting with the Home tab (refer to Figure 1.16), we have quick access to many of the major design tools and functionality that we will be leveraging through the BIM design life cycle:
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			Figure 1.16 – Home

			Next up is the Insert tab (refer to Figure 1.17), where we can quickly make connections to other types of files for reference purposes. Based on the type of file(s) being referenced, we can either keep these as static overlays being displayed or can make them live elements within our drawing area:
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			Figure 1.17 – Insert

			Next up is the Annotate tab (refer to Figure 1.18), where we can quickly add labels and text to various design elements:
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			Figure 1.18 – Annotate

			Next up is the Modify tab (refer to Figure 1.19), where we can quickly adjust design elements within the drawing:
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			Figure 1.19 – Modify

			Next up is the Analyze tab (refer to Figure 1.20), where we can quickly access various reporting and computational tools and functionality available to us:
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			Figure 1.20 – Analyze

			Next up is the View tab (refer to Figure 1.21), where we can quickly adjust our display settings of modeled elements in our drawing area:
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			Figure 1.21 – View

			Next up is the Manage tab (refer to Figure 1.22), which, in a way, is more of a parking lot that provides quick access to a multitude of options, such as connecting to individual design elements from other Civil 3D files, performing customizations to the overall user interface, and file cleanup options:
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			Figure 1.22 – Manage

			Next up is the Output tab (refer to Figure 1.23), where we can quickly export our drawing and individual design elements to a variety of formats:
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			Figure 1.23 – Output

			Next up is the Survey tab (refer to Figure 1.24), where we can quickly access various survey and mapping tools to support our BIM designs:
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			Figure 1.24 – Survey

			Next up is the Rail tab (refer to Figure 1.25), where we can quickly access BIM design capabilities related to Rail:
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			Figure 1.25 – Rail

			Next up is the Transparent tab (refer to Figure 1.26), where we can quickly access functionality that can be applied while performing various commands throughout our BIM design:
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			Figure 1.26 – Transparent

			Next up is the InfraWorks tab (refer to Figure 1.27), where we can quickly connect to InfraWorks by importing/exporting design elements generated within either the Civil 3D or InfraWorks platform:
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			Figure 1.27 – InfraWorks

			Next up is the Collaborate tab (refer to Figure 1.28), where we can quickly share our drawings and BIM design elements in various cloud-based environments:
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			Figure 1.28 – Collaborate

			Next up is the Help tab (refer to Figure 1.29), where we can quickly access additional support as needed:
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			Figure 1.29 – Help

			Next up is the Add-ins tab (refer to Figure 1.30), where we can quickly access any add-ins that are integrated with Civil 3D:
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			Figure 1.30 – Add-ins

			Next up is the Express Tools tab (refer to Figure 1.31), where we can quickly access various ad hoc tools:
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			Figure 1.31 – Express Tools

			Next up is the Featured Apps tab (refer to Figure 1.32), where we can quickly access the Autodesk App Store to purchase and install leading add-ins being leveraged across the AEC industry:
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			Figure 1.32 – Featured Apps

			And finally, located at the very end of this tier just to the right of the Featured Apps tab is an icon that will give you the ability to cycle through the visibility states of the ribbon (as shown in Figure 1.33):
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			Figure 1.33 – Ribbon visibility states

			Going back to what I said about the Menu bar visibility, depending on preference, you have the ability to either toggle on or off the tabs and panels display as well. Seeing as how the tabs and panels do consume a bit more real estate, or area, at the top of the session, you can minimize, even temporarily, to increase the space available in the drawing area as well (more on that in a bit). Ultimately, it comes down to preference of access and is in your hands to decide.

			With the contents of the second level behind us, let’s jump into the third.

			The third tier of the ribbon

			In the third and final level of the ribbon interface, we have the panels that are categorized one more level down and provide access to the actual tools and functionality available within Autodesk’s Civil 3D (refer to Figure 1.34):

			
				
					[image: Figure 1.34 – Ribbon panel

]
				

			

			Figure 1.34 – Ribbon panel

			It’s far more important, in my opinion, to fully understand the purpose and functionality of these tools when we review real-world design workflows and applications of tools. With that said, all of the tools and functionality within each of the tabs and panels will be covered in future sections and chapters within this book, so I won’t bore you with too much detail at this time. Please refer to Figures 1.15 to 1.33 for a high-level overview of what is included from a panel standpoint within each of the tabs.

			Before moving on to the next area of the user interface, it is important to note that the ribbon we have been exploring is contextual, meaning it will change the commands that are visible on the ribbon depending on the command you are using or on what object is selected in the drawing. When an object is selected, the contextual ribbon will display commands directly related to the object you have selected in an attempt to expedite related workflows. Next, you can see the contextual ribbon in its default state, as shown in Figure 1.35:
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			Figure 1.35 – Contextual ribbon when a command or tool is not active

			The following figure shows when a tool or command is active or when modeled components are selected in the drawing area:
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			Figure 1.36 – Contextual ribbon when a command or tool is active

			The major differences between the displays are the tools and commands that will be made available above your drawing area. The intent of this contextual ribbon is to narrow down the tool selections to what can actually be performed with the identified objects. This eliminates all kinds of unnecessary time trying to remember where to locate tools and ultimately makes your work much easier.

			With the contents of the third level behind us, let’s move on to the Toolspace.

			Toolspace

			The next part of the user interface that we’ll review is Toolspace. This can be accessed by going to the Home tab and selecting the Toolspace icon in the Palettes panel. Once activated, you’ll notice TOOLSPACE being displayed along the left-hand side of your session (refer to Figure 1.37):
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			Figure 1.37 – Toolspace access

			Within TOOLSPACE, you are presented with a ton of file and design management tools and functionality that will really drive your BIM design and the way modeled geometry and components are displayed. Along the right-hand side of your TOOLSPACE area, you’ll notice four individual tabs that will give you access to each type of functionality, Prospector, Settings, Survey, and Toolbox (refer to Figure 1.38):
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			Figure 1.38 – Toolspace tabs

			Let’s look at each type of functionality:

			
					The Prospector tab provides you with the ability to create, modify, analyze, and manage modeled geometry and components within your drawing(s) open in the current session, as well as link modeled geometry and components from other files via Data Shortcuts Manager.

					The Settings tab provides you with the ability to create, modify, and manage settings specific to the drawing(s) open in the current session.

					The Survey tab provides you with the ability to connect to survey databases and manage configurations to streamline the integration of data within Autodesk’s Civil 3D platform.

					The Toolbox tab provides you with additional reporting and analysis tools that work well for gathering information within the current drawing and exporting data to various reporting formats.

			

			With the contents of the toolspace reviewed, let’s now jump into the drawing area.

			Drawing area

			Moving on, the next area is the drawing area, which is fairly straightforward and self-explanatory. This area is reserved for your actual BIM design modeling, annotating, and so on. All your work will be displayed in this area and will appear as shown in this screenshot:
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			Figure 1.39 – Drawing area

			You’ll notice, however, a few different icons within your drawing area that are worth pointing out and providing a little more detail on. In the upper left-hand corner, you’ll notice a few view descriptions, similar to [-] [Top] [2D Wireframe]. When you select each of these fields, you are presented with the ability to further manage and/or change the display of all elements displayed in the drawing area. If you select the first field, [-], you are presented with a few options to customize the drawing area, or model space viewport (shown in Figure 1.40):
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			Figure 1.40 – Customize model space viewport

			If you select the second field, [Top], you are presented with a few options to customize the orientation of the view being displayed within your model space viewport (shown in Figure 1.41):
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			Figure 1.41 – Model space viewport view orientation

			If you select the third field, [2D Wireframe], you are presented with the ability to change the overall display of your model geometry and components within the model space viewport (shown in Figure 1.42):
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			Figure 1.42 – Model space viewport display

			Let’s move over to the upper right-hand corner of your drawing area. This is where you’ll find ViewCube (refer to Figure 1.43), which allows you to quickly change the user coordinate system (UCS) and view orientation of components displayed in your drawing area. By selecting any of the lettered directions or the rotation options in the top right, or selecting any location on the square/cube located in the center, the view orientation will update as you select each of the options.
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			Figure 1.43 – ViewCube

			Additionally, if you select the down arrow toward the bottom right of ViewCube, you are presented with some additional view settings, along with display options for ViewCube itself (see Figure 1.44):
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			Figure 1.44 – ViewCube settings

			Lastly, just underneath ViewCube, you’ll notice a Quick View Access Bar, as shown in Figure 1.45. On this bar, we have the ability to quickly pull up the Full Navigation Wheel that will display right next to your mouse, pan across your drawing (represented by the hand icon), zoom in/out of your view, orbit/rotate your view along an axis, and ShowMotion, which allows you to create animations.
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			Figure 1.45 – Quick View Access Bar

			With the contents of the drawing area reviewed, let’s move on to understanding the command line.

			Command line

			Last, but not least, we have the command line (refer to Figure 1.46). Any time you are in a command, and not presented with a dialog box, you will see the next steps for your command being displayed at the command line.
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			Figure 1.46 – Command line

			It’s important to keep an eye on the command line if you are in doubt as to what the next step of your command is. Further, if you’re a “typer” like I am, this is also a great place to type any shortcuts of commands instead of trying to locate them within any of the menu dropdowns or sorting through the tools displayed in the ribbons. As an example, you can type the letters CO in the command line and hit Enter or the spacebar to initiate the Copy command, type the letter M and hit Enter or the spacebar to initiate the Move command, and so on.

			Now that we have a high-level understanding of what tools are available to us and where they are located within the Autodesk Civil 3D environment, let’s jump into understanding the dynamic nature of the platform to get a little more of an idea as to how best we can leverage it in a BIM design setting.

			Understanding Civil 3D elements

			Now that we’re getting a little more familiar with the various access points to locate our tools, let’s try to get a better understanding of the overall functionality and capabilities of Autodesk’s Civil 3D. The way this BIM design authoring tool is built allows for multiple design geometry and components to be linked dynamically and, in a way, speak to each other. When one component is updated, it can potentially affect many other components that are built on top of it.

			When you think about building a house, you start with a foundation, then you typically frame the house on top of the foundation, and then finish with the walls, roof, doors, windows, insulation, and so on. Thinking about how this workflow applies on the civil engineering side, we typically start with a survey, next we’ll lay out our proposed site geometry as the framework, and then build everything else based on this framework (roadways, utilities, etc.).

			Within Autodesk’s Civil 3D, we can create the following intelligent components that have the potential to be linked dynamically to each other:

			
					Points

					Surfaces

					Sites

					Alignments

					Profiles

					Sections

					Pipe networks (gravity utility networks)

					Pressure networks

					Corridors

			

			Putting each of these in the context of the previously mentioned constructional workflow, each of these components identified in the list is a stepping stone to the next component. If we start with points (surveyed or proposed), we can ultimately create a surface from those points. If a surface is created from those points, and we change the elevation, the surface will dynamically change as well.

			Sites, alignments, profiles, and sections would be in closer alignment with the framework concept where we are establishing, or designing, some basic site geometry that our BIM design model will be built on top of, acting as more of a guide.

			Then we get into the heart of the design matter, where we jump into pipe networks, pressure networks, and corridors. Yes, we can design some of these BIM design components without establishing the foundational and framework elements, however, we would truly be limited in what we can do from a design standpoint.

			That said, we would essentially be setting ourselves up for a lot of questions that can’t be answered later on down the road. By establishing the foundational and framework elements first, we are not only setting ourselves up for a more successful design but also giving ourselves the ability to answer questions about our BIM design models at any given point in time. A thoroughly constructed BIM design model will give you the benefit and assurance in the long run that what is displayed in the drawing area can actually be constructed.

			With that, we should have a fairly decent glimpse into how Civil 3D design elements function and how each is, in a way, connected to each other and can truly impact a BIM design.

			Summary

			In this chapter, we learned about the fundamental navigation tools and Civil 3D elements that will act as the basis for our design as we compound on this chapter going forward. Civil 3D has a very intuitive and adaptive navigation workflow to ensure the analysis and design process transitions seamlessly as we move from step to step.

			With the contextual ribbon, the main commands for building upon our design automatically highlight to expedite decision making. Civil 3D provides additional methods of navigation as well as you dive further into specific workflows and begin to customize your method of working.

			With a firm understanding of utilizing the navigation tools, we can effectively begin our analysis and design with the core Civil 3D elements. We learned about the different elements within the software and how they respond to different parameters and functions.

			In addition to this, we learned about the Civil 3D process that links these elements together in a dynamic way to mitigate redundant work and ensure objects dependent upon each other maintain such integration through the evolution of our designs.

			In the next chapter, we will learn about the details of some of these elements and dive further into their inner workings for proper and confident designs. As we explore these new elements in further detail, we will build upon the knowledge of this chapter and demonstrate their dynamic nature in incredibly fast and adaptive workflows as projects change and adjust, as is common with industry work.

			Civil 3D is a program that adapts with you at your pace for maintaining focus on the design and not wasting time understanding how the program should work. Successive chapters will build upon the previous chapters, so at any point, if questions arise, feel free to return to those chapters and connect any gaps there may be.

		

		
			
			

		

	
		
			2

			Setting up the Design Environment

			Now that we have begun to familiarize ourselves, and get a bit more comfortable, with the overall layout of Civil 3D, we can start to look at how to set ourselves up for successful design implementation moving forward. A critical step to any BIM design is establishing a foundation to build upon.

			With that said, in this chapter, we will review how work begins within Civil 3D; we will look at how to create efficient practices from the start with file templates and settings that carry through as our drawings get more advanced and we generate more files along the way. We will also gain a bit more insight into the dynamic nature of Civil 3D and how so many of the functions within it are linked, leading to a dramatic reduction in rework and a large increase in file intelligence.

			In this chapter, we will cover the following topics:

			
					Exploring the Toolspace within Civil 3D

					Customizing object styles and object label styles

					Expediting project work with file templates

			

			Technical requirements

			The technical requirements of this chapter are identical to the previous chapter. Please refer to the requirements listed in Chapter 1, Introduction to Civil 3D, for reference.
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